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 SAFETY PRECAUTIONS  
(Always read these precautions prior to use.) 

Before using this product, please read this manual and the relevant manuals introduced in this manual 
carefully and pay full attention to safety to ensure that the product is used correctly. 
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REVISIONS 
*The manual number is given on the bottom left of the back cover. 

Print Date *Manual Number Revision 
Oct., 2006 50EM8665-A First Edition 

   

   

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. 
Mitsubishi Electric Engineering Company cannot be held responsible for any problems involving industrial property 
rights which may occur as a result of using the contents noted in this manual. 

© 2006 MITSUBISHI ELECTRIC ENGINEERING COMPANY LIMITED 
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INTRODUCTION 

Thank you for purchasing the EQLDR01 program loader data conversion utility function software package 
manufactured by Mitsubishi Electric Engineering Company Limited (hereafter “MEE”). Prior to use, please 
read this manual and the EQLDR01 Program Loader Operating Manual carefully to develop full familiarity with 
the functions and performance of the general-purpose PLC MELSEC series manufactured by Mitsubishi 
Electric Corporation, so as to ensure correct use. 
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Generic Terms and Abbreviations 

This manual uses the following generic terms and abbreviations in product explanations, 
unless otherwise specified. The module model is stated when needed. 

Generic Term/Abbreviation Description 

Program Loader 
An abbreviated name for MELSEC-Q Series Basic Model QCPU 
EQLDR01 Program Loader. 

CF card An abbreviated name for compact flash card. 

GX Developer 
A generic term for the product models SWnD5C-GPPW, 
SWnD5C-GPPW-A, SWnD5C-GPPW-V and SWnD5C-GPPW-VA (n refers 
to each version 0 to 8). 

Basic model QCPU A generic term for Q00JCPU, Q00CPU and Q01CPU. 
High-performance model 
QCPU 

A generic term for Q02(H)CPU, Q06HCPU, Q12HCPU and Q25HCPU. 

Process CPU A generic term for Q12PHCPU and Q25PHCPU. 
QCPU (A mode) A generic term for Q02(H)-A and Q06H-A. 

QCPU (Q mode) 
A generic term for QOOJ, Q00, Q01,Q02(H), Q06H, Q12H, Q12PH, Q25H 
and Q25PHCPU. 

Trademarks 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other 
countries. 
Acrobat is a trademark or registered trademark of Adobe Systems Incorporated. 
All other company names and product names that appear in this manual are the trademarks or registered 
trademarks of their respective owners. 

 
 

Caution  

� MEE does not provide any guarantee for the Microsoft® Windows® operating system compatible 
commercial software products introduced in this manual. 

� The software of this product is copyrighted to MEE. 
� Any unauthorized copying or reproduction of this document in whole or in part by any means without 

prior written consent is strictly prohibited. 
� Whilst MEE makes every effort to update the content of this manual as software and hardware 

revisions are made, simultaneous updates are not always possible. 
� One product software license must be purchased for each computer. 
� Use of this product (and manual) is possible based solely on the Software License Agreement. 
� MEE shall not be held responsible for any effect related to the result of operating this product (using 

this manual). 
� The content of this manual is subject to change without notice. 
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1. OVERVIEW 

This manual describes the system configuration, specifications, handling and function 
operation methods of the EQLDR01 Program Loader Data Conversion Utility Function 
Software Package (hereafter “utility”). 
This utility is a software package for converting a project that was created using GX 
Developer into program data that can be written to a PLC using Program Loader, and for 
converting Program Loader data loaded from a PLC by Program Loader into a GX 
Developer project so that the data can be read using GX Developer. 

1.1 Features 

(1) Transferring data via CF card 
In the past, when data such as program or parameter data was to be saved on a CF 
card, Program Loader had to be connected to the PLC CPU to load the data. 
This utility allows you to perform the following even without a PLC CPU: 

• Convert a GX Developer project to Program Loader data and save the data 
on a CF card. 

• Convert Program Loader data on a CF card to a GX Developer project and 
save the project on a PC. 

(2) Support of data with password 
When a password that prohibits data writing is set for data on the PLC CPU, the 
utility converts the project with the password set, thereby enabling writing. (Reading 
from the PLC is not possible.) 

1.2 Function List 

The following is a list of the functions of the utility. 

No. Function Name Process Overview 

1 
Convert GX Developer Project → Program 
Loader Data 

Converts a GX Developer project to Program 
Loader data and saves the data. 

2 
Convert Program Loader Data → GX Developer 
Project 

Converts Program Loader data to a GX 
Developer project and saves the project. 
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2. SYSTEM CONFIGURATION 
 

2.1 System Configuration 

 

Basic mode QCPU 

EQLDR01 Program 
Loader 

CF card 
(commercial 

product) 

GX Developer 
operable DOS/V PC 

Data Conversion Utility 
Function Software 

Package 

 

2.2 Operating Environment 

The following describes the operating environment of the utility. 

DOS/V PC 
A PC with Windows 2000  
A PC with Windows XP 

OS 
Windows2000 Professional 
WindowsXP Professional/Home Edition 

CPU 
600MHz or higher 
(Multiprocessor not applicable) 

Display Resolution: 1024 x 768 dots or higher 
Memory 64MB or higher (128MB or higher with Windows XP) 

HD free space 
At installation: 200MB or higher (recommended) 
At execution: 100MB virtual memory space or higher 
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3. INSTALLING AND UNINSTALLING THE UTILITY 

This chapter describes how to install and uninstall the utility. 

3.1 Installing the Utility 

 

3.1.1 Installation procedure 

The following describes how to install the utility. 

 

Start the application. 
• Check if the utility was properly

installed. 

Install the product. 
• Accept the Software License

Agreement. 
• Complete user registration. 

New installation Version upgrade 

End 
Start the application. 
• Check if the utility was properly 

installed. 

Install the product. 
• Accept the Software License 

Agreement. 
• Complete user registration. 

End 

Uninstall the old version. 

 
 
 
 

Point 
If a confirmation message regarding the replacement of various DLLs appears during 
installation, select OK and replace the DLLs. Failure to replace the DLLs may cause the 
product to not run properly. 
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3.1.2 Installation operation 

Prior to installation, check the following. 
 

Point 
• Prior to installation, close all other applications running on Windows®. 
• When using Windows® XP Professional, Windows® XP Home Edition or 

Windows® 2000 Profession, log in as a user with Administrator (computer 
administrator) attributes. 

 
[1] Start Windows® Explorer and click 

the drive where the disk is inserted. 
Run “SETUP.EXE”. 

 

[2] Prior to installation, close all other 
applications running on Windows® 
and click the OK button. To cancel 
installation, click the Cancel button. 
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[3] Initial installation screen 
To execute install, click the Next > 
button. To cancel installation, click the 
Cancel button. 

[4] Specify the installation destination 
folder. The installation destination 
folder appears. If the folder is 
acceptable, click Next >.  
To change the folder, click Browse… 
and specify the target drive and folder.

 

[5] Installation is completed. Click OK. 

Remarks 
When this product is installed, the icon is registered under [Start] → [All Programs] → [MEE] → [EQLDR01 
Data Conversion Utility]. 
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3.2 Uninstalling the Utility 

The following describes how to remove the product from your hard disk. 
[1] Select “Add or Remove Programs” 

from the Control Panel. To display 
the Control Panel, select [Start] → 
[Control Panel]. 

[2] Select the software package to be 
removed or changed. Select 
“EQLDR01 Data Conversion Utility”. 

 

[3] Confirm software package removal. 
To uninstall the utility, click Yes. To 
not uninstall the utility and return to 
the previous screen, click No. 
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[4] Program removal is completed. Click 
the OK button. 
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4. OPERATION PROCEDURE 

This chapter describes the flow of utility operation. 

4.1 Operation Flow 

Start the utility

Main screen

"Select data conversion
source (GX Developer

project)" screen

...Refer to Section 4.2.3.
Select "Convert GX
Developer project →
"Program Loader data"

... Refer to
Section 4.2.4.

"Select data for
conversion to Program
Loader data" screen

... Refer to
Section 4.2.5.

When password applicable
data is selected

"Set password"
screen

... Refer to
Section 4.2.6.

"Specify save location
of converted Program
Loader data" screen

... Refer to
Section 4.2.7.

Select "Convert Program
Loader data → "GX
Developer project"

... Refer to
Section 4.2.8.

... Refer to
Section 4.2.9.

... Refer to
Section 4.2.10.

"Select data conversion
source (Program Loader

data)" screen

"Select data for conversion
to GX Developer project"

screen

"Specify save location of
converted GX Developer

project" screen
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4.2 Operation Method 

The following describes how to operate the utility. 

4.2.1 Starting the utility 

To start the utility, click [Start] → [All Programs (P)] → [MEE] → [EQLDR01 Data 
Conversion Utility] → [EQLDR01 Data Conversion Utility]. 
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4.2.2 Main screen 

On the main screen, select either “Convert GX Developer Project → Program Loader 
Data” or “Convert Program Loader Data → GX Developer Project”. 

[Operation procedure] 
Start the application. The following screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Convert GX Developer project into EQLDR data 
Click this item if you want to convert a GX Developer project to Program Loader 
data. 

[2] Convert EQLDR data into GX Developer project 
Click this item if you want to convert Program Loader data to a GX Developer 
project. 

[3] Help button 
This button displays the operating manual. For details, refer to Section 4.3, “Help 
Function.” 

[4] Exit button 
Click this button to exit the utility. When the button is clicked, the following message 
appears. Click Yes. The utility closes. 

 

[1] 

[2] 

[4] 

[3] 
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4.2.3 “Select data conversion source (GX Developer project)” screen 

On the “Select data conversion source (GX Developer project)” screen, select the GX 
Developer project that is to serve as the conversion source when converting a GX 
Developer project to Program Loader data. 

[Operation procedure] 
On the main screen, click the Convert GX Developer project into EQLDR data button. The 
screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Project drive 
In this area, select the drive where the GX Developer project is saved. 

[2]  (Upper Folder) button 
This button displays the upper folder. 

[3]  (Switch View) button 
This button switches the project list (Item [4]) view to simple or detailed. 

 

(Example of 
detailed display) 

[5] 

[7] 

[3] 

[4] 

[8] 

[1] 
[2] 

[6] 
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[4] Project list 
This area shows a list of the projects in the selected folder. When the detailed view 
is selected with the Switch View button, the list shows the CPU type, created date 
and title. If the CPU type does not appear in the detailed view, the data may be 
corrupted. 

[5] Drive/Path 
In this area, specify the drive/path name of the project to be selected. 

[6] Project name 
In this area, specify the name of the project to be selected. 

[7] Next > button 
This button advances the screen to the “Select data for conversion to Program 
Loader data” screen. 

 

Point 
• The Next > button cannot be clicked if a conversion source project is not selected.
• When a project other than QUTE is selected, an error appears. 

  
• When a project opened using GX Developer is selected, an error appears. 

  

 

[8] Cancel button 
Click this button to cancel the conversion process. The following message appears. 
Clicking Yes returns the screen to the main screen. 
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4.2.4 “Select data for conversion to Program Loader data” screen 

On the “Select data for conversion to Program Loader data” screen, select the GX 
Developer project data to be converted when converting a GX Developer project to 
Program Loader data. 

[Operation procedure] 
On the “Select data conversion source (GX Developer project)” screen, select a GX 
Developer project and click the Next > button. The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Select Program memory button 
Click this button to select all data applicable to program memory. 

[2] Select Standard ROM button 
Click this button to select all data applicable to standard ROM. 

[3] Select Standard RAM button 
Click this button to select all data applicable to standard RAM. 

[10]

[7] 

[9] 

[1][2][3][4] 
[5] 
[6] 

[8] 

[11] [12] [13] 
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[4] Cancel all selections button 
Click this button to clear all data selections. 

[5] “Write label programs (STs, FBs, structures) (program memory)” checkbox 
Click this box when you want to write label programs to the program memory of the 
PLC CPU. A checkmark appears in the box. This checkbox is disabled when 
program (program memory) is not selected. The checkbox is always disabled when 
the project does not have label information. 

[6] “Write label programs (STs, FBs, structures) (standard ROM)” checkbox 
Click this box when you want to write label programs to the program memory of the 
PLC CPU. A checkmark appears in the box. This checkbox is disabled when 
program (standard ROM) is not selected. The checkbox is always disabled when 
the project does not have label information. 

[7] Data list 
This area shows a list of convertible data. The name of the target memory in 
parentheses is the conversion destination. Placing a checkmark in the checkbox on 
the left of the data (the data checkbox) selects that data for conversion to Program 
Loader data. 

[8] File register range 
This area sets the range of the file register. The area is disabled when a file register 
is not selected. 

Point 
• The input range is 0 to 65535. 
• If the end number is smaller than the start number, if a value outside the input 

range is set, or if the start number or end number has not been entered, an error 
occurs. 

[9] Title (Program memory) 
This area is used to set the title of program memory. A total of 32 single-byte 
characters or 16 double-byte characters can be entered. 

[10] Title (Standard ROM) 
This area is used to set the title of standard ROM. A total of 32 single-byte 
characters or 16 double-byte characters can be entered. 

[11] < Back button 
Click this button to return the screen to the previous “Select data conversion source 
(GX Developer project)” screen. 
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[12] Next > button 
Click this button to continue the conversion process after selecting the data to be 
converted. Clicking the button advances the screen to the “Set password” screen 
when a program, device comment or device initial value is selected. When a 
program, device comment or device initial value is not selected, the screen 
advances to the “Specify save location after conversion” screen. 

[13] Cancel button 
Click this button to cancel the conversion process. A message appears. Click OK. 
The screen returns to the main screen. 
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4.2.5 “Set password” screen 

On the “Set password” screen, set a password when password applicable data has been 
selected for conversion to Program Loader data. 
If a password is already set for the PLC CPU where Write to PLC is to be performed using 
Program Loader, set the same password. 

[Operation procedure] 
On the “Select data for conversion to Program Loader data” screen, select a program, 
device comment or device initial value and click the Next > button. The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Program memory / Standard ROM 
This area is used to set the password for the target memory program, comment or 
device initial value, as well as password registration conditions (write prohibited, 
read/write prohibited). 
The password setting is enabled for only the data selected on the “Select data for 
conversion to Program Loader data” screen. 
If the password is omitted, no password is set. 

[1] 

[2] 

[1] 

[3] [4] 
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Point 
• The following indicates the relationship of the operation at the time of Read from 

PLC and Write to PLC of Program Loader when a password is set. 
 
[At the time of Read from PLC of Program Loader] 

(○: Read possible, ×: Read not possible) 
Password Registration Status of PLC Data 

No password Write Prohibited Write/Read Prohibited
○ ○ × 

 
[At the time of Write to PLC of Program Loader] 

(○: Write possible, △: Write possible if password matches) 
Password Registration Status of PLC Data 

No password Write Prohibited Write/Read Prohibited
○ △ △  

[2] < Back button 
Click this button to return to the previous “Select data for conversion to Program 
Loader data” screen. 

[3] Next > button 
Click this button to continue the conversion process after setting the password. The 
screen advances to the “Specify save location of converted Program Loader data” 
screen. If the password is omitted, no password is set. 

[4] Cancel button 
Click this button to cancel the conversion process. A message appears. Click OK. 
The screen returns to the main screen. 
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4.2.6 “Specify save location of converted Program Loader data” screen 

On the “Specify save location of converted Program Loader data” screen, specify the save 
location of data converted from a GX Develop project to Program Loader data. 

[Operation procedure] 
On the “Select data for conversion to Program Loader data” screen, select the data to be 
converted and click the Next > button. The screen appears. 
Or, on the “Set password” screen, click the Next > button. The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Drive 
In this area, select the drive for saving the Program Loader data. 
Example: Select the drive where the CF card used for Program Loader is inserted. 

[2]  (Upper Folder) button 
This button displays the upper folder. 

[3]  (Switch View) button 
This button switches the Program Loader data list view to simple or detailed. 

 

(Example of 
detailed display)

[1] 
[2] 

[3] 

[4] 

[5] 

[6] [7] [8] 
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[4] Program Loader data list 
This area displays a list of Program Loader data located in the selected folder. 

[5] Drive/Path 
In this area, specify the drive/path name of the project to be selected. 

[6] < Back button 
Click this button to return to the previous “Select data for conversion to Program 
Loader data” screen or “Set password” screen. 

[7] Next > button 

a) Click this button to save the converted Program Loader data to the specified 
folder. 

b) When the Program Loader data has already been saved, the following 
message appears: 

 
Click Yes if it is OK to replace the data. 

c) A conversion confirmation message appears. 

 
Click Yes to convert the data. 

d) The following message appears when conversion is successfully completed. 

 
Pressing the OK button returns the screen to the main screen. 
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Point 
• Only one type of Program Loader data can be saved in a single file. If you want to 

convert and save multiple GX Developer projects, divide the folder where the data 
is to be saved. 

• With device comment conversion, the comment range that is set in the project is 
used. 

[8] Cancel button 
Click this button to continue the conversion process. A message appears. Click Yes. 
The screen returns to the main screen. 



4. OPERATION PROCEDURE 
 

4-14           4-14 

4.2.7 “Select data conversion source (Program Loader data)” screen 

On the “Select data conversion source (Program Loader data)” screen, select the folder 
where the program loader data that is to serve as the conversion source is saved when 
converting Program Loader data to a GX Developer project. 

[Operation procedure] 
On the main screen, select the Convert EQLDR data into GX Developer project button. 
The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Drive 
This area is used to select the drive where the Program Loader data is saved. 
Example: Select the drive where the CF card used for Program Loader is inserted. 

[2]  (Upper Folder) button 
This button displays the upper folder. 

[3]  (Switch View) button 
This button switches the Program Loader data list view to simple or detailed. 

 

(Example of 
detailed display)

[1] 
[2] 
[3] 

[4] 

[5] 

[6] [7]
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[4] Program Loader data list 
This area displays a list of the Program Loader data located in the selected folder. 

 

Point 
• Only a maximum of one set of Program Loader data is saved in a single folder. 
• The Program Loader data name is fixed to “Program Loader data”. 

[5] Drive/Path 
In this area, specify the drive/path name for the Program Loader data to be 
selected. 

[6] Next > button 
Click this button to continue conversion after selecting the folder for saving the 
Program Loader data to be converted to a GX Developer project. The screen 
advances to the “Select data for conversion to GX Developer project” screen. 

[7] Cancel button 
Click this button to cancel the conversion process. A message appears. Click OK. 
The screen returns to the main screen. 
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4.2.8 “Select data for conversion to GX Developer project” screen 

On the “Select data for conversion to GX Developer project” screen, select the data to be 
converted to a GX Developer project when converting data from Program Loader data to a 
GX Developer project. 

[Operation procedure] 
On the “Select data conversion source (Program Loader data)” screen, click the Next > 
button after selecting the folder where the Program Loader data to be converted is saved. 
The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Select Program memory button 
Click this button to select all data applicable to program memory. 

[2] Select Standard ROM button 
Click this button to select all data applicable to standard ROM. 

[3] Select Standard RAM button 
Click this button to select all data applicable to standard RAM. 

[4] Clear all selections button 
Click this button to clear all data selections. 

[6] 

[3]

[5] 

[7] 

[1] 

[2] 

[4]

[8] [9] [10] 
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[5] Data list 

This area shows a list of convertible data. The name of the target memory in 
parentheses is the conversion source. Placing a checkmark in the checkbox  on 

the left of the data (the data checkbox) selects that data for conversion to a GX 
Developer project. 

[6] Title (Program memory) 
This area shows the title of program memory. The title cannot be modified. 

[7] Title (Standard ROM) 
This area shows the title of standard ROM. The title cannot be modified. 

[8] < Back button 
Click this button to return the screen to the previous “Select conversion source (GX 
Developer project)” screen. 

[9] Next > button 
Click this screen to continue the conversion process after selecting the data to be 
converted. Clicking the button advances the screen to the “Specify save location of 
converted GX Developer project” screen. 

[10] Cancel button 
Click this button to cancel the conversion process. A message appears. Click OK. 
The screen returns to the main screen. 
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4.2.9 “Specify save location of converted GX Developer project” screen 

On the “Specify save location of converted GX Developer project” screen, specify the 
project save location when converting Program Loader data to a GX Developer project. 

[Operation procedure] 
On the “Select data for conversion to GX Developer project” screen, select the data and 
click the Next > button. The screen appears. 

[Setting screen] 

 

[Item explanation] 

[1] Project drive 
In this area, select the drive for saving the GX Developer project. 

[2]  (Upper Folder) button 
This button displays the upper folder. 

[3]  (Switch View) button 
This button changes the view of the project list (Item [4]) to simple or detailed. 

[4] Project list 
This area displays a list of projects already saved in the selected folder. When 
detailed view is selected with the Switch View button, the CPU type, created date 
and title are displayed. 

[5] Drive/Path 
In this area, specify the drive/path name of the project to be saved. 

[5] 

[1] 

[6] 

[3] 

[4] 

[2] 

[7] 

[8] [9] [10] 
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[6] Project name 
In this area, specify the name of the project to be saved. 

[7] Title 
In this area, specify the title of the project to be saved. 

[8] < Back button 
Click this button to return to the previous “Select data for conversion to GX 
Developer project” screen. 

[9] Next > button 

a) Click this button to save the converted GX Developer project under the 
specified project name. 

b) A conversion confirmation message appears. 

 
Click Yes to convert the data. 

c) When the specified project does not exist, the following message appears. 

 
To create a new project, click Yes. 

d) When the project has already been saved, the following message appears. 

 
To replace the project, click Yes. 
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e) When conversion is successfully completed, the following message appears. 

 
Click OK to return to the main screen. 

[10] Cancel button 
Click this button to cancel the conversion process. A message appears. Click Yes. 
The screen returns to the main screen. 
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4.2.10 Exiting the utility 

[Operation procedure] 
When the application is started, the main screen appears. Exit the utility from the main 
screen. 

[Setting screen] 

 

[Item explanation] 

[1] Exit button 
Click this button to exit the utility. The following message appears. Click Yes. The 
utility closes. 

 

[1] 
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4.3 Help Function 

The Help function allows you to display this operating manual. 
To display the manual, Acrobat Reader (Version 5.0 or higher) is required. 

4.3.1 Displaying the user’s manual from the utility 

The following describes how to display the operating manual from the utility. 

[Operation procedure] 
When the application is started, the main screen appears. Display the operating manual 
from the main screen. 

[Setting screen] 

 

[Item explanation] 

[1] Help button 
This button displays the operating manual. 

4.3.2 Displaying the user’s manual from Windows 

The following describes how to display the operating manual from Windows®. 

[Operation procedure] 
Click [Start] → [All Programs (P)] → [MEE] → [EQLDR01 Data Conversion Utility] → 
[EQLDR01 Data Conversion Utility Manual]. The operating manual file appears. 

[1] 
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Example of operating manual display 
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Appendices 
 

Appendix 1 Error Message List 

The following describes the error messages that occur in the utility. 

(1) Error messages when converting a GX Developer project to Program Loader data 

Displayed message Error Cause Action 

A program that has not been converted 
or complied has been specified. 
Execute the operation after converting 
or compiling the program. 

A non-converted or non-compiled 
project exists. 

Convert/Compile all programs using 
GX Developer. 

The PLC type of the label program is 
not the same. The program cannot be 
loaded. 

The PLC type of the label program 
differs from that of the GX Developer 
project. 

Check if the project can be successfully 
loaded using GX Developer. If it cannot, 
the project is corrupted and must be 
recreated. 

A directory with the same file name as 
Program Loader has been specified. 
The file cannot be saved. 

A directory with the same name as 
the data name to be saved already 
exists. 

Change the name of the data to be 
saved. 

Failed to load label program file. The 
process will be aborted. 

The label program file may be 
corrupted. 

Check if the project can be successfully 
loaded using GX Developer. If it cannot, 
the project is corrupted and must be 
recreated. 

Cannot convert data. Check the 
conversion source data. 

The GX Developer project may be 
corrupted. 

Check if the project can be successfully 
loaded and written to QCPU using GX 
Developer. 

The project is of a CPU type that is not 
supported. This project cannot be 
converted. 

A project other than QUTE was 
selected as the data conversion 
source when converting a GX 
Developer project to Program Loader 
data. 

Select a QUTE project. 

New, Open, Save as and Delete cannot 
be performed with the specified project. 
Possible cause are as follows: 
• A project already specified by 

another application is open. 
• A project on a write-protected FD 

is specified. 

A GX Developer project opened by 
another application was selected. Or, 
a write-protected project was 
selected. 

Close the GX Developer project 
opened by the other application. Or, 
change the project to write enabled. 

The end number of the specified file 
register range is smaller than the start 
number. 

The end number of the file register 
range specified on the “Select data 
for conversion to Program Loader 
data” screen was set to a value 
smaller than the start number. 

Specify the numbers so that the end 
number is larger than the start number.

The file register head device number is 
invalid. 

The start number for the file register 
range specification was not entered 
on the “Select data for conversion to 
Program Loader data” screen. 

Enter the head number. 
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Displayed message Error Cause Action 

The file register last device number is 
invalid. 

The end number for the file register 
range specification was not entered 
on the “Select data for conversion to 
Program Loader data” screen. 

Enter the last number. 

The number of file register device 
points exceeds the maximum number. 

The file register range specification 
exceeds the maximum number of 
points (65535) on the “Select data for 
conversion to Program Loader data” 
screen. 

Set the number of file register device 
points to 65535 or less using GX 
Developer. 

There is no data in the comment 
(COMMENT) area. Writing was not 
performed. 

The device comment was selected 
but the data for the comment range to 
be written was blank. 

Specify data that has a device 
comment in the comment range setting.

The converted data exceeds capacity. 
The process will be aborted. 

Data of a size that clearly exceeded 
the maximum memory capacity of the 
target CPU was converted. 

Correct the comment and program 
using GX Developer so that the amount 
of project data decreases. 

Note: This project was created using 
the Version 6 or Version 7 label 
program. When a project is saved with 
this version and opened with an older 
version, the following occurs: 
• Opened with Version 7: The 

project becomes a label + FB 
project. 

• Opened with Version 6: The 
project becomes a no label project 
and the labels cannot be restored. 

A label program created using GX 
Developer Version 6 or 7 was 
specified. 

Using Program Loader, specify a 
project of a label program created using 
GX Developer Version 8 or later. 

Failed to load project file. The project 
cannot be opened. Possible causes are 
as follows: 
• The data in the project file is 

completely corrupted. 
• The project file contains data 

created using a version that is 
newer than this product. 

• There is no project file. 

The GX Developer project could not 
be loaded when converting the GX 
Developer project to Program Loader.

Check if the project can be successfully 
loaded using GX Developer. If it cannot, 
the project is corrupted. Recreate the 
project. 

Failed to get project data from project 
file. The data in the project file is 
completely corrupted. The project 
cannot be opened. 

The GX Developer project could not 
be successfully loaded when 
converting the GX Developer project 
to Program Loader. 

Check if the project can be successfully 
loaded using GX Developer. If it cannot, 
the project is corrupted. Recreate the 
project. 

The specified file does not exist. 
Specify an existing project path/name. 

When the project name was entered 
using the keyboard, a non-existing 
project name was specified. 

First specify and then execute an 
existing project path/name. 

The entered password is incorrect. 
Enter the correct password. 

A password of four characters was 
not entered. 

Specify the password using a 
combination of four characters, which 
may include numbers, upper-case 
letters and lower-case letters. 
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(2) Error messages when converting Program Loader data to a GX Developer project 

Displayed message Error Cause Action 

The Program Loader data is corrupted. The Program Loader data may be 
corrupted. 

Using Program Loader, load the data 
once again from the PLC and convert 
the data once again. 

Failed to write label program file. The 
process will be aborted. 

The label program file may be 
corrupted. 

Try restarting the PC and executing the 
operation once again or reinstalling and 
re-executing the program. 

Failed to create new project. A GX Developer project cannot be 
created due to insufficient memory, 
etc. 

Close any other programs that are 
running and execute the operation 
once again. Or, reinstall and re-execute 
the program. 

Failed to save project. The GX Developer project cannot be 
successfully saved due to insufficient 
HD space, etc. 

Either increase the amount of HDD 
space or select a drive with more space 
and execute the operation once again.

The project cannot be saved to the 
specified drive. Possible causes are as 
follows: 
An error occurred during saving. 
• There is not enough memory to 

save the project. 
• The medium on the specified drive 

is corrupted. 

The drive of the save destination may 
be corrupted or the amount of 
available memory is insufficient. 

Check the drive to be used for saving, 
close any other programs running and 
execute the operation once again. 

The project name or data name is a 
reserved device name. Select a 
different name. 

A reserved device name (COM1 to 
COM9, LPT1 to LPT9, AUX, CON, 
PRN, NUL, CLOCK$) was specified 
as the project name. 

Specify a name other than the reserved 
device name. 

The project path contains a prohibited 
character. The characters 
/,:,,,;,*,?,"",<,>,| cannot be used in the 
project path. 

A /,:,,,;,*,?,"",<,>,| character was used 
in the project path name. 

Specify a project path name that does 
not include prohibited characters. 

A directory name comprised only of 
spaces is specified as the directory. A 
directory of spaces only cannot be 
created. 

A directory consisting of spaces only 
was specified. 

Specify a directory name other than 
spaces. 

The directory specified contains a 
series of ¥ characters. Do not specify 
the character ¥ in series. 

A series of ¥ characters was specified 
for the directory. 

Specify a directory without using a 
series of ¥ characters. 

A period cannot be placed at the end of 
the project name. 

A period was entered at the end of the 
project name. 

Use a character other than a period at 
the end of the project name. 

The project name contains a prohibited 
character. The characters 
/,:,,,;,*,?,"",<,>,| cannot be used in the 
project name. A project name 
consisting of spaces only will also result 
in an error. 

A /,:,,,;,*,?,"",<,>,| character was used 
in the project name. 

Specify a project name that does not 
include prohibited characters. 

The number of characters that can be 
used has been exceeded. Set the item 
using 150 characters or less. 

The number of characters in the 
conversion destination GX Developer 
project name + path exceeds 150. 

Specify the conversion destination GX 
Developer project name and path name 
using 150 characters or less. 
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(3) Other error messages 

Displayed message Error Cause Action 

OLE initialization failed. Check if the 
OLE library is the correct version. 

An invalid version of OLE System 
DLL may be installed. 

Reinstall the utility and then execute 
the operation once again. 

The number of selectable data items 
has been exceeded. The maximum 
number of selectable data items in 
XXXX is n. 

The number of data items selected 
exceeds the number selectable when 
multiple device memories or multiple 
file registers exist. 

Specify data items in an amount within 
the maximum range. 

Cannot access the specified drive. 
Possible causes are as follows: 
• The drive is not ready. 
• The amount of free space on the 

drive is insufficient. 

The amount of free space on the 
HDD used is insufficient for 
conversion using Program Loader. 

Delete unnecessary files to free up 
HDD space, and execute the operation 
once again. 

Failed to read CPU definition file. The 
registry information may be corrupted 
or the CPU definition file may not exist. 
Install the file once again. 

The CPU definition file 
(CPUTYPE.DAT) is corrupted. 

Reinstall and execute the operation 
once again. 

Insufficient memory. Close any other 
applications that are currently running. 

The amount of free memory space 
may be insufficient. 

Close any other programs that are 
currently running, and execute the 
operation once again. 

Failed to generate project. The amount of free memory space 
may be insufficient. 

Close any other programs that are 
currently running, and execute the 
operation once again. 

Failed to initialize project. The project 
cannot be opened. 

The amount of free memory space 
may be insufficient. 

Close any other programs that are 
currently running, and execute the 
operation once again. 

Insufficient memory. The EQLDR01 
data conversion utility cannot be 
started. Close all other applications and 
start the EQLDR01 data conversion 
utility once again. 

The amount of free memory space 
may be insufficient. 

Close any other programs that are 
currently running, and execute the 
operation once again. 

The specified drive cannot be used. 
Check if a disk is inserted. 

A disk is not inserted in the specified 
drive. 

Insert the disk in the drive and execute 
the operation once again. 

Selection is not possible. Specify a 
drive/path using 150 characters or less. 

The number of drive/path characters 
exceeds 150. 

Specify the drive/path using 150 
characters or less. 

Cannot start Acrobat Reader. Acrobat 
Reader may not be installed. Install 
Acrobat Reader. 

Either Acrobat Reader is not installed 
or the Manual.pdf file cannot be 
found. 

If Acrobat Reader is not installed, install 
Acrobat Reader. If the Manual.pdf file is 
non-existent, reinstall the utility. 

 



 

Product Warranty Details 

Please confirm the following product warranty details prior to product use. 

Gratis Warranty Terms and Gratis Warranty Range 

If any fault or defect (hereinafter referred to as “Failure”) attributable to Mitsubishi Electric Engineering 
Company Limited (hereinafter referred to as “MEE”) should occur within the gratis warranty period, MEE shall 
repair the product free of charge via the distributor from whom you made your purchase. 

J Gratis Warranty Period 
The gratis warranty period of this product shall be one (1) year from the date of purchase or delivery to 
the designated place. 
Note that after manufacture and shipment from MEE, the maximum distribution period shall be six (6) 
months, and the gratis warranty period after manufacturing shall be limited to eighteen (18) months. 
In addition, the gratis warranty period for repaired products shall not exceed the gratis warranty period 
established prior to repair. 

J Gratis Warranty Range 
The gratis warranty range shall be limited to normal use based on the usage conditions, methods and 
environment, etc., defined by the terms and precautions, etc., given in the instruction manual, user’s 
manual and caution labels on the product. 

Warranty Period after Discontinuation of Production 

(1) MEE shall offer product repair services (fee applied) for seven (7) years after production of the product 
has been discontinued. Discontinuation of production shall be reported via distributors. 

(2) Product supply (including spare parts) is not possible after production has been discontinued. 

Exclusion of Opportunity Loss and Secondary Loss from Warranty Liability 

Regardless of the gratis warranty period, MEE shall not be liable for compensation for damages arising from 
causes not attributable to MEE, opportunity losses or lost profits incurred by the user due to Failures of MEE 
products, damages or secondary damages arising from special circumstances, whether foreseen or 
unforeseen by MEE, compensation for accidents, compensation for damages to products other than MEE 
products, or compensation for other work carried out by the user. 

Changes in Product Specifications 

The specifications given in the catalogs, manuals and technical documents are subject to change without 
notice. 
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